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Le présent document comprend des descriptions générales et/ou des caractéristiques techniques des 

produits mentionnés. Il ne peut pas être utilisé pour définir ou déterminer l'adéquation ou la fiabilité de 

ces produits pour des applications utilisateur spécifiques. Il incombe à chaque utilisateur ou intégrateur 

de réaliser l'analyse de risques complète et appropriée, l'évaluation et le test des produits pour ce qui est 

de l'application à utiliser et de l'exécution de cette application. Ni la société Schneider Electric ni aucune 

de ses sociétés affiliées ou filiales ne peuvent être tenues pour responsables de la mauvaise utilisation 

des informations contenues dans le présent document. Si vous avez des suggestions d'amélioration ou 

de correction ou avez relevé des erreurs dans cette publication, veuillez nous en informer. 

Aucune partie de ce document ne peut être reproduite sous quelque forme ou par quelque moyen que 

ce soit, électronique, mécanique ou photocopie, sans l'autorisation écrite expresse de Schneider Electric.

Toutes les réglementations locales, régionales et nationales pertinentes doivent être respectées lors de 

l'installation et de l'utilisation de ce produit. Pour des raisons de sécurité et afin de garantir la conformité 

aux données système documentées, seul le fabricant est habilité à effectuer des réparations sur les 

composants.

Lorsque des équipements sont utilisés pour des applications présentant des exigences techniques de 

sécurité, suivez les instructions appropriées. 

La non-utilisation du logiciel Schneider Electric ou d'un logiciel approuvé avec nos produits matériels peut 

entraîner des blessures, des dommages ou un fonctionnement incorrect.

Le non-respect de cette consigne peut entraîner des lésions corporelles ou des dommages matériels.

© 2010 Schneider Electric. Tous droits réservés.
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§

Consignes de sécurité
Informations importantes

AVIS

Lisez attentivement ces instructions et examinez le matériel pour vous familiariser avec l'appareil avant 

de tenter de l'installer, de le faire fonctionner ou d’assurer sa maintenance. Les messages spéciaux 

suivants que vous trouverez dans cette documentation ou sur l'appareil ont pour but de vous mettre en 

garde contre des risques potentiels ou d’attirer votre attention sur des informations qui clarifient ou 

simplifient une procédure.

 

 

 

 

REMARQUE IMPORTANTE

L’installation, l’utilisation, la réparation et la maintenance des équipements électriques doivent être 

assurées par du personnel qualifié uniquement. Schneider Electric décline toute responsabilité quant aux 

conséquences de l’utilisation de cet appareil.

Une personne qualifiée est une personne disposant de compétences et de connaissances dans le 

domaine de la construction et du fonctionnement des équipements électriques et installations et ayant 

bénéficié d'une formation de sécurité afin de reconnaître et d’éviter les risques encourus.
1639573 12/2010 5
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A propos de ce manuel
Présentation

Objectif du document

S’appuyant sur un exemple d’application, le guide de démarrage rapide explique comment rapidement 

installer, configurer et utiliser le système TeSys® T. 

Ce document ne se substitue pas aux documents suivants :

 Manuel utilisateur Contrôleur de gestion de moteur TeSys T LTM R Profibus-DP  

 Instruction de service TeSys T LTM R

 Instruction de service TeSys T LTM E

Document à consulter

Vous pouvez télécharger ces publications et autres informations techniques depuis notre site web à 

l'adresse : www.schneider-electric.com.

Commentaires utilisateur

Envoyez vos commentaires à l'adresse e-mail techpub@schneider-electric.com

Titre de documentation Référence

Manuel utilisateur Contrôleur de gestion de moteur TeSys T LTM R Profibus-DP 1639502

Instruction de service TeSys T LTM R•• AAV7709901 

Instruction de service TeSys T LTM E•• AAV7950501 

Manuel utilisateur Unité de contrôle opérateur TeSys T LTM CU 1639581

Instruction de service TeSys T LTM CU 1639582
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Guide de démarrage rapide
Vue d'ensemble de l'exemple d'application

Introduction

Le guide de démarrage rapide illustre chaque étape du processus d'installation, de configuration et 

d'utilisation du TeSys T à l'aide d'un exemple d'application.

Dans l’exemple d’application suivant, le contrôleur LTM R sert à protéger et à contrôler un moteur et sa 

charge d’entraînement, soit une pompe. 

Cet exemple d’application a pour objectif de :

 vous montrer comment configurer le contrôleur LTM R en quelques étapes simples ;

 permet de développer votre propre configuration en modifiant ce même exemple ;

 sert de point de départ au développement de configurations plus complexes, en ajoutant des fonction-

nalités supplémentaires, comme le contrôle IHM ou Réseau.

Fonctions effectuées

Lorsque le contrôleur LTM R est configuré afin de protéger et de contrôler le moteur et la pompe, il assure 

les fonctions suivantes :

 protection contre les surcharges thermiques ;

 protection du capteur de température du moteur ;

 protection de la tension/contre les sous-tensions ;

 protection contre les défauts de mise à la terre externe ;

 configuration système initiale pendant la mise en service à l’aide d'un PC et du logiciel PowerSuite.

Conditions de fonctionnement

Les conditions de fonctionnement de l'exemple d'application sont les suivantes :

 alimentation du moteur : 4 kW

 tension composée : 400 V CA

 intensité : 9 A

 tension du circuit de commande : 230 V CA

 commande 3 fils

 moteur - classe de déclenchement 10

 bouton de démarrage

 bouton d’arrêt

 bouton de réarmement situé sur la porte du boîtier

 voyant de défaut

 voyant d’alarme

 démarreur à un sens de marche, fonctionnant à la tension maximale (démarrage direct)

 tension de 24V CC à l'intérieur du centre de commande du moteur ou du poste de commande pour 

une utilisation future avec les entrées du module d'extension LTM E.

Conditions du réseau

Les conditions réseau de l'exemple sont les suivantes :

 protocole : Profibus-DP

 adresse : 4

 vitesse en bauds : 3 Mb/s

Le contrôleur LTM R est configuré à l'aide de PowerSuite et non via le réseau (le paramètre configuration 

- par port réseau est désactivé).

La configuration logicielle réseau décrite dans ce document repose sur :

 logiciel de configuration de réseau Sycon

 logiciel de programmation Unity

 plate-forme d'automate Premium

Composants utilisés

L'exemple d'application utilise les composants suivants :

Elément Description du composant Numéro de référence

1 LTM R Contrôleur de gestion de moteur LTM R 100-240 V CA Profibus-DP 

(FLC de 1,35...27 A)

LTMR27PFM

2 LTM E Module d’extension LTM E 24 V CC LTMEV40BD

3 Câble de connexion RJ45 LTM R à LTM E LTMCC004

4 Kit de câbles PowerSuite VW3A8106
10 1639573 12/2010
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5 PowerSuite Logiciel sur CD-ROM, version ≥ 2.5 PowerSuite

6 TC de défaut de mise à la terre externe TA30

7 Capteur de température du moteur - PTC binaire externe Fourni par l’utilisateur

Elément Description du composant Numéro de référence
1639573 12/2010 11
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Présentation du système de gestion de moteur TeSys T

Vue d'ensemble du système

Le système de gestion de moteur TeSys T offre des fonctions de protection, de commande et de 

surveillance pour les moteurs à induction CA monophasés et triphasés.

Le système propose également des fonctions de diagnostic et de statistiques, ainsi que des défauts et 

des alarmes configurables afin de mieux anticiper la maintenance des composants. Il fournit enfin des 

données permettant d’améliorer en permanence le système dans son ensemble.

Les 2 principaux composants matériels du système sont :

 le contrôleur LTM R, et

 le module d’extension LTM E.

Présentation du système

Les tableaux suivants décrivent les principaux composants du système de gestion de moteur TeSys T. 

Contrôleur LTM R Description fonctionnelle Numéro de référence

 détection de l’intensité : de 0,4 à 100 A

 entrées monophasées ou triphasées

 6 entrées TOR logiques

 4 sorties relais : 3 unipolaires unidirectionnels, 1 

bipolaire unidirectionnel

 connexions pour capteur de courant de fuite à la 

terre

 connexion pour capteur de température du moteur

 connexion réseau

 connexion pour IHM ou module d’extension

 fonctions de protection, de mesure et de 

surveillance de l’intensité

 fonctions de contrôle du moteur

 voyant d’alimentation

 voyants de défaut et d’alarme

 voyants de communication réseau et d’alarme

 voyant de communication avec l’IHM

 fonction de test et de réinitialisation

LTMR08PBD (24 V CC, FLC de 

0,4 à 8 A)

LTMR27PBD (24 V CC, FLC de 

1,35 à 27 A)

LTMR100PBD (24 V CC, FLC 

de 5 à 100 A)

LTMR08PFM (100 à 240 V CA, 

FLC de 0,4 à 8 A)

LTMR27PFM (100 à 240 V CA, 

FLC de 1,35 à 27 A)

LTMR100PFM (100 à 240 V CA, 

FLC de 5 à 100 A)

Module d’extension 

LTM E

Description fonctionnelle Numéro de référence

 détection de la tension de 110 à 690 V CA

 entrées de tension triphasées

 4 entrées logiques “Tout ou Rien” supplémentaires

 fonctions de protection, de mesure et de 

surveillance de la tension supplémentaires

 voyant d’alimentation

 voyants d’état des entrées logiques

Composants supplémentaires requis pour un module 

d’extension optionnel : 

 câble pour la connexion du contrôleur LTM R au 

module LTM E

LTMEV40BD (entrées logiques de 

24 V CC)

LTMEV40FM (entrées logiques de 

100 à 240 V CA)

Logiciel PowerSuite Description fonctionnelle Numéro de référence

 configuration du système grâce à des entrées de 

menu

 affichage de paramètres, des alarmes et des 

défauts détectés

 commande du moteur

Composants supplémentaires requis pour le logiciel 

PowerSuite : 

 PC

 source d’alimentation séparée

 câble de communication entre LTM R/LTM E et le 

PC

PowerSuite ≥ v 2.5 

VW3A8106

(kit de câble PowerSuite)
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Description du LTM R et du LTM E

Les schémas suivants présentent les fonctions du contrôleur LTM R et du module d'extension :

Unité de contrôle 

opérateur LTM CU

Description fonctionnelle Numéro de référence

 configuration du système grâce à des entrées de 

menu

 affichage de paramètres, des alarmes et des 

défauts détectés

 commande du moteur

Composants supplémentaires requis pour une IHM 

optionnelle :

 câble de communication entre LTM R/LTM E et 

l'IHM

 câble de communication entre l'IHM et le PC

LTM CU

VW3A1104R.0

(câble de communication avec 

l’IHM)

VW3A8106 

(kit de câble PowerSuite)

LTM9KCU

Kit pour LTM CU portable

Contrôleur LTM R Module d’extension LTM E

1 Bouton Test/Reset

2 Port IHM avec connecteur RJ45 reliant le contrôleur LTM R à une IHM, 

à un PC ou à un module d’extension LTM E

3 Port réseau avec connecteur sub-D 9 broches reliant le contrôleur 

LTM R à un automate Profibus

4 Voyants d’état

5 Bornier enfichable : alimentation de contrôle, source commune et 

entrées alimentées en interne

6 Bornier enfichable : relais de sortie bipolaire unidirectionnel

7 Bornier enfichable : relais de sortie

8 Bornier enfichable : entrée de défaut à la terre et entrée du capteur de 

température

9 Bornier enfichable : réseau de l’automate

1 Port avec connecteur RJ45 pour le 

raccordement à une IHM ou à un 

PC

2 Port avec connecteur RJ45 pour le 

raccordement au contrôleur LTM R

3 Voyants d’état

4 Bornier enfichable : entrées de 

tension

5 Bornier enfichable : entrées 

logiques et source commune

I.7 C7 I.8 C8 I.9 C9

LV1 LV2 LV3

I.10 C10

I.7 I.8 I.9Power I.10

LTMEV40FM

2

4

5

1

3

1639573 12/2010 13



Guide de démarrage rapide
Installation

Vue d'ensemble

La procédure suivante décrit comment installer et configurer physiquement le système TeSys T selon les 

conditions de fonctionnement de l'exemple d'application. La procédure est identique pour les autres 

configurations.

La procédure d'installation est présentée dans sa totalité sur les fiches d'instructions fournies avec le 

contrôleur LTM R et le module d'extension LTM E. Elle est également détaillée dans le chapitre 

Installation du manuel utilisateur.

Les schémas suivants présentent les dimensions du contrôleur LTM R et du module d'extension LTM E : 

DANGER
RISQUE DE CHOC ELECTRIQUE, D’EXPLOSION OU D’ARC ELECTRIQUE

Mettez l'équipement hors tension avant toute opération.

Portez des équipements de protection individuelle (EPI) adaptés et respectez les procédures de 

sécurité.

Le non-respect de ces instructions provoquera la mort ou des blessures graves.

LTM R LTM E
14 1639573 12/2010
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Montage du LTM R et du LTM E

Montez le contrôleur LTM R et le module d'extension LTM E en respectant l'espacement requis et la 

position de fonctionnement. 

Connexion du LTM R au LTM E

Connectez le contrôleur LTM R et le module d'extension LTM E à l'aide du câble RJ45.

Connexion à une IHM TeSys T LTM CU (optionnelle)

Les illustrations ci-dessous montrent la connexion de l'IHM TeSys T LTM CU au contrôleur LTM R, avec 

et sans le module d'extension LTM E :

1 Unité de contrôle opérateur LTM CU

2 Câble RJ45 (VW3 A1 104R30, dans cet exemple)

3 Contrôleur LTM R

4 Module d’extension LTM E

Les schémas ci-dessous indiquent comment monter le contrôleur LTM R et le module d'extension LTM E sur un rail 

DIN, une plaque de montage plein ou une plaque Telequick :

Ce schéma présente les positions de fonctionnement possibles : 
1639573 12/2010 15
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Câblage des transformateurs de courant

Câblez les transformateurs de courant en fonction des conditions de fonctionnement :

 Plage du produit → 1,35...27 A

 Intensité nominale du moteur → 9 A

Dans ce cas, 1 passage à travers les ouvertures du transformateur de courant suffit, bien que 2 passages 

soient possibles :

Câblage du transformateur de courant de fuite à la terre

Câblez le transformateur de courant de fuite à la terre :

Fil LTM R

 Raccordez l'alimentation et les E/S.

 Raccordez les capteurs de température.

Fil LTM E

Raccordez les transformateurs de tension et les E/S du module d'extension LTM E.

ATTENTION
RISQUE DE DESTRUCTION DES ENTREES

Raccordez les entrées du contrôleur LTM R en utilisant les 3 bornes communes (C) connectées à la 

tension de contrôle A1 via un filtre interne.

Le non-respect de ces instructions peut provoquer des dommages matériels.
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Câblage du contrôleur LTM R

Le schéma ci-dessous illustre le circuit d'alimentation principal et le contrôle local à 3 fils (par impulsion) 

fonctionnant en mode de contrôle réseau, correspondant à l'exemple d'application.

1 Contacteur

2 Transformateur de courant de fuite à la terre

3 Thermistance PTC binaire

4 Indication d'alarme détectée

5 Indication de défaut détecté

L Contrôle local

O Eteint

N Contrôle Réseau

KM1

3

14

O.1

23 24

O.2 O.3
LTMR

+/~
-/~

A2A1 I.1 C I.2 I.3

Start

C I.4 CI.5 I.6 95 9697 98

O.4

Stop

LTME

I7 C7 I8 C8 I9 C9 I10 C10

LV1 LV2 LV3

Z1 T1 T2Z2

Reset

KM1

33 3413

1

3

2

54

L NO
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Configuration

Vue d'ensemble

Une fois les connexions réalisées, configurez les paramètres à l'aide du logiciel PowerSuite (voir le 

chapitre PowerSuite du manuel utilisateur).

Installation du logiciel

Connexion au logiciel PowerSuite™

Définition des paramètres

AVERTISSEMENT
FONCTIONNEMENT IMPREVU DE L’APPAREIL

L'application de ce produit nécessite d'être compétent dans la conception et la programmation des 

systèmes de contrôle. Seules les personnes possédant ces compétences doivent être autorisées à 

programmer et à utiliser ce produit.

Respectez la réglementation locale et nationale en matière de sécurité.

Le non-respect de ces instructions peut provoquer la mort, des blessures graves ou des dom-

mages matériels.

Etape Description

1 Insérez le CD d’installation dans le lecteur de CD/DVD de votre PC.

2 Accédez au fichier setup.exe et cliquez dessus. L'assistant d'installation se lance.

3 Suivez les instructions données dans l'assistant d'installation.

Exemple d'application :

1 PC équipé du logiciel PowerSuite

2 PowerSuite Kit de câbles VW3 A8 106

3 Contrôleur LTM R

4 Module d’extension LTM E

Si vous n'utilisez pas le module d'extension, branchez 

l'IHM directement sur le contrôleur :

1 PC équipé du logiciel PowerSuite

2 PowerSuite Kit de câbles VW3 A8 106

3 Contrôleur LTM R

Etape Description

1 Lancez le logiciel PowerSuite.

2 Sur l'écran Load Configuration, sélectionnez le fichier de configuration et ouvrez-le avec les réglages 

usine par défaut.

3 Développez la branche Device Information de l'arborescence et définissez les paramètres de 

fonctionnement.

4 Ouvrez la branche Settings du contrôle de l’arborescence.

5 Dans la sous-branche Motor and Control, localisez et définissez les réglages de fonctionnement.

6 Répétez l'étape 5 pour toutes les autres sous-branches.

7 Enregistrez une copie des paramètres de configuration définis dans un nouveau fichier de configuration.
18 1639573 12/2010
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Liste des réglages de paramètres

Définition des paramètres de l'exemple d'application :

(1) Reportez-vous à la section Paramètres du courant pleine charge (FLC - Full Load Current), page 21.

Branche Device 

Information

Sous-branche Paramètre Réglage

Device information — Plage d'intensité 1,35-27 A

Réseau Profibus-DP

Tension de contrôle 100-240 V CA

Branche Settings Sous-branche Paramètre Réglage

Motor and Control 

Settings

Motor operating mode Tension nominale 400 V

Puissance nominale 4 kW

Mode de 

fonctionnement

Indépendant 3 fils

Contacteur - courant 

de coupure

9 A

Phase 3 phases

Motor temperature sensor Type de capteur PTC binaire

Validation défaut Activer

Niveau de défaut Selon le moteur

Niveau d'alarme Selon le moteur

Load CT TC charge - rapport Interne

Passages TC 

charge
1 (1)

Ground CT TC terre - rapport 1000:1

Control mode Contrôle local Déclenchement du bornier

Thermal Settings Thermal overload Type de 

déclenchement

Inversion thermique

Classe de 

déclenchement

10

FLC1 (1) 50 % (1) (équivalent à 9 A)

Validation défaut Activer

Validation alarme Activer

Current Settings Ground Current Mode Validation défaut Activer

Niveau de défaut 1 A

Temporisation 

défaut

0,5 s

Validation alarme Activer

Niveau d'alarme 200 mA

Voltage Settings Undervoltage Validation défaut Activer

Niveau de défaut 85 %

Temporisation 

défaut

3 s

Validation alarme Activer

Niveau d'alarme 90 %
1639573 12/2010 19
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Transfert du fichier de configuration

Etape Description

1 Ouvrez le fichier de configuration à transférer.

 Assurez-vous que le fichier apparaît dans la fenêtre principale.

2 Connectez votre PC au contrôleur LTM R.

 Vérifiez dans la barre des tâches si votre PC est connecté au contrôleur LTM R.

3 Transférez le fichier de configuration :

 Sélectionnez PC to Device dans le sous-menu Link → File Transfer ou à partir de la barre des icônes.

 Dans la boîte de dialogue Upload Configuration, cliquez sur Continue. Une barre de progression 

apparaît brièvement.

 Pour avoir confirmation de la réussite du transfert, vérifiez les résultats dans la fenêtre Output qui 

s'ouvre automatiquement en bas de la fenêtre principale.

Résultat : Le produit est maintenant prêt à être utilisé.
20 1639573 12/2010
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Paramètres du courant pleine charge (FLC - Full Load Current)

Notions fondamentales relatives au FLC

NOTE : Avant de régler le FLC, vous devez d’abord définir le courant de coupure du contacteur et le 

rapport du transformateur de courant (TC) de charge.

TC charge - rapport = TC charge - primaire / (TC charge - secondaire * Passages)

Courant - maximum du capteur = Courant - plage maximum * TC charge - rapport

La plage de courant maximum est indiquée sur la référence commerciale du contrôleur LTM R. Elle est 

stockée en valeurs allant jusqu’au dixième d’ampère et propose les valeurs suivantes : 8,0 ; 27,0 ou 

100,0 A.

Le courant de coupure du contacteur est stocké en valeurs allant jusqu’au dixième d’ampère. Il est 

défini entre 1,0 et 1000,0 A par l’utilisateur.

FLCmax correspond à la valeur la plus basse entre Courant - maximum du capteur et Contacteur - 

courant de coupure.

FLCmin = Courant maximal du capteur / 20 (arrondi à 0,01 A). Le courant pleine charge minimum 

(FLCmin) est stocké en interne en valeurs allant jusqu’au centième d’ampère.

NOTE : Ne définissez pas de valeur FLC inférieure à la valeur FLCmin.

Conversion d’ampères en paramètres FLC

Les valeurs FLC sont stockées sous la forme d’un pourcentage de FLCmax

FLC (en %) = FLC (en A) / FLCmax

NOTE :  Les valeurs FLC doivent être exprimées en pourcentage de la valeur FLCmax  (résolution de 

1 %). Si vous entrez une valeur non autorisée, le contrôleur LTM R l’arrondit à la valeur autorisée la plus 

proche. Par exemple, sur une unité de 0,4 à 8 A, la valeur entre les FLC est de 0,08 A. Si vous essayez 

de définir une valeur FLC de 0,43 A, le contrôleur LTM R l'arrondira à 0,4 A.

Exemple (sans TC externe) 

Données :

 FLC (en A) = 9 A

 Courant - plage maximum = 27,0 A

 TC charge - primaire = 1

 TC charge - secondaire = 1

 Passages = 1 ou 2

 Contacteur - courant de coupure = 18,0 A

 

Paramètres calculés sur la base d'un passage :

 TC charge - rapport = TC charge - primaire / (TC charge - secondaire * Passages) = 1 / (1 * 1) = 1,0

 Courant - maximum du capteur = Courant - plage maximum * TC charge - rapport = 27,0 * 1,0 = 27,0 A

 FLCmax = min. (Courant - maximum du capteur, Contacteur - courant de coupure) = min. (27,0 ; 18,0) 

= 18,0 A

 FLCmin = Courant - maximum du capteur / 20 = 27,0 / 20 = 1,35 A

 FLC (en %) = FLC (en A) / FLCmax = 9,0 / 18,0 = 50 %

 

Paramètres calculés sur la base de 2 passages :

 TC charge - rapport = 1 / (1 * 2) = 0,5

 Courant - maximum du capteur = 27,0 * 0,5 = 13,5 A

 FLCmax = min (13,5, 18,0) = 13,5 A

 FLCmin  = Courant - maximum du capteur  / 20 = 13,5 / 20 = 0,67 A

 FLC (en %) = FLC (en A) / FLCmax = 9,0 / 13,5 = 66 %
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Diagnostic

Voyants LTM R et LTM E 

Comme l'exemple d'application utilise le contrôleur LTM R et le module d'extension LTM E, vous devez 

vérifier les voyants sur les deux systèmes :

Voyants

Utilisez les 5 voyants situés sur la face avant du contrôleur LTM R pour surveiller son état, comme 

indiqué ci-dessous :

Les 5 voyants situés sur la face avant du module d’extension LTM E permettent de surveiller son état :

Voyant 

LTM R

Couleur Renseigne sur Signification

HMI Comm Jaune L’activité de communication entre le 

contrôleur LTM R et le module d’extension

 Jaune clignotant = communication

 Eteint = aucune communication

Power Vert Défaut interne ou défaut d’alimentation du 

contrôleur LTM R

 Vert continu = alimentation active, 

moteur coupé, pas de défaut interne

 Vert clignotant = alimentation active, 

moteur démarré, pas de défaut interne

 Eteint = alimentation coupée ou défauts 

internes

Alarm Rouge Alarme ou défaut de protection, ou défaut 

interne

 Rouge continu = défaut interne ou de 

protection

 Rouge clignotant (2 fois par s) = alarme

 Rouge clignotant (5 fois par s) = 

délestage ou cycle rapide

 Eteint = aucun défaut, alarme, délestage 

ou cycle rapide (lorsque l’alimentation est 

active)

Fallback Rouge La communication entre le contrôleur 

LTM R et le module réseau

 Rouge continu = en état de repli

 Eteint = pas en état de repli (alimentation 

coupée)

BF Jaune Activité de communication sur le bus 

réseau

 Jaune clignotant (allumé durant 0,2 s, 

éteint durant 1 s) = communication sur le 

bus réseau

 Eteint = Pas de communication sur le bus 

réseau

Voyant LTM E Couleur Renseigne sur Signification

Power Vert ou 

rouge

Défaut interne ou défaut 

d’alimentation du module

 Vert continu = alimentation active, aucun défaut 

interne

 Rouge continu = alimentation active, présence 

de défauts internes

 Eteint = alimentation coupée

Entrées 

numériques I.7, 

I.8, I.9 et I.10

Jaune Etat de l’entrée  Allumé = entrée activée

 Eteint = entrée désactivée
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Utilisation de l'unité de contrôle opérateur TeSys T LTM CU

Fonctions disponibles

Une fois connecté au LTM R, le LTM CU peut être utilisé pour : 

 configurer les paramètres du contrôleur LTM R ; 

 afficher des informations sur la configuration et le fonctionnement du contrôleur LTM R ; 

 surveiller les alarmes et les défauts générés par le contrôleur ;

 contrôler le moteur localement via l'interface de contrôle locale.

Face avant du LTM CU

La face avant du LTM CU est illustrée ci-dessous :

1 Ecran LCD

2 Touches de navigation contextuelles

3 Port RJ45 (recouvert) de la face avant destiné au raccordement du PC

4 Interface de contrôle locale, avec les 5 touches de commande et les 4 voyants

Touches de navigation

Les touches de navigation de l'unité LTM CU sont contextuelles, c'est-à-dire que leur fonction dépend 

des icônes associées et affichées sur l'écran LCD. Ces icônes varient selon l'écran affiché et, par 

conséquent, la fonction des touches de navigation aussi. 

Les touches de navigation permettent de :

 parcourir les menus et les sous-menus ;

 faire défiler une liste de valeurs ;

 sélectionner une valeur dans une liste ;

 quitter une liste de valeurs sans effectuer de sélection ;

 retourner au menu principal (premier niveau) ;

 basculer entre les modes Manuel et Automatique en affichage Quick View.
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L'illustration ci-dessous donne un exemple des différentes fonctions de chaque touche de navigation 

associées à une icône sur l'écran LCD : 

1 Zone d'informations sur l'écran LCD

2 Zone réservée aux icônes de navigation contextuelles de l'écran LCD

3 Permet d'accéder au menu de niveau supérieur

4 Accès à l'option suivante du menu

5 Sélection d'une option

6 Accès à l'option précédente du menu

7 Retour au menu principal

Ecrans LCD

L'unité  LTM CU possède trois affichages :

Icônes de navigation contextuelles 

Le tableau suivant décrit les icônes utilisées avec les touches de navigation de l'unité LTM CU :

Ecran LCD Fonctionnalité

Menu  Affichage et modification des paramètres requis pour la configuration du 

contrôleur LTM R (mesure, protection, contrôle et services)

 Affichage de données de diagnostic et historiques

Quick View  Affichage en temps réel des valeurs des paramètres présélectionnés avec 

défilement automatique ou manuel

Alarmes et défauts détectés  Affichage de l'alarme ou du défaut détecté le plus récent

Icône Description Icône Description

Permet d'accéder au menu principal à partir 

d'un sous-menu ou de l'affichage Quick View

Permet d'accéder au menu principal à partir 

d'un sous-menu ou de l'affichage Quick View

Permet de faire défiler l'écran vers le bas Permet d'accéder au mode de défilement 

manuel (lorsque l'affichage Quick View est en 

mode de défilement automatique)

Permet de faire défiler l'écran vers le haut Permet d'accéder au mode de défilement 

automatique (lorsque l'affichage Quick View 

est en mode de défilement manuel)

Permet de valider un paramètre ou une valeur 

et d'accéder à un sous-menu lorsqu'un menu 

est sélectionné

Permet d'augmenter une valeur (écran menu)

Permet d'accéder au menu de niveau 

supérieur

Permet de diminuer une valeur (écran menu)

Lorsqu'une option de menu est protégée par 

un mot de passe, cette icône permet d'accéder 

à l'écran de saisie du mot de passe.
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Icônes informatives

Le tableau suivant décrit les icônes informatives qui apparaissent dans la zone d'informations de l'écran 

LCD. Elles indiquent, entre autres, le menu ou le paramètre sélectionné :

Exemple d'affichage de l'IHM

Voici un exemple d'affichage de l'IHM indiquant un courant moyen de 0,39 A sur le canal de contrôle 

Local, en mode de fonctionnement :

1 Icône de l’affichage Quick View

2 Nom du paramètre actuellement affiché

3 Etat du moteur 

4 Raccourci vers le menu principal

5 Icône du mode de défilement manuel (si vous appuyez sur la touche de navigation contextuelle associée, vous 

passez en mode de défilement manuel.)

6 Valeur du paramètre actuellement affiché

Icône Description Icône Description

Menu principal Indique que l'écran actuel est en mode Quick 

View

Menu des paramètres de mesure Indique qu'une alarme s'est déclenchée

Menu des paramètres de protection Indique qu'une erreur a été détectée

Menu des paramètres de contrôle Informations

Menu d'entretien Case cochée

Menu de sélection de langue Case désélectionnée

Case d'option sélectionnée Option sélectionnée (pour être incluse dans 

l'affichage Quick View)

Case d’option désélectionnée Contrôleur LTM R en mode de configuration
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Réseau de communication sur Profibus-DP

Câblage du port de communication

Cette procédure est indiquée sur les fiches d'instructions fournies avec le LTM R et le LTM E, et elle est 

décrite dans le chapitre Installation du manuel utilisateur : 

Définition des paramètres

Pour l'exemple d'application, définissez les paramètres suivants : 

Le paramètre Port réseau - perte communication est activé par défaut. Si nécessaire, vous pouvez le 

désactiver.

Configuration de la communication

Exemple de configuration de réseau :

Branche Settings Sous-branche Paramètre Réglage

Device information — Réseau Profibus-DP

Communication Network port Adresse 4

Etape Action

1 Importez votre fichier GSD en sélectionnant File → Copy GSD.

2 Sélectionnez l’emplacement où les fichiers GS* ont été dézippés et cliquez sur OK.

3 Ajoutez un maître : 

 cliquez sur Insert → Master..., ou

 sélectionnez .

4 Sélectionnez la vitesse réseau : 

 cliquez sur Settings → Bus Parameter → Baud rate.,

 sélectionnez la valeur en bauds correspondant à la vitesse de transmission de votre application (3000 

kbits/s, par exemple).

Les esclaves Profibus adaptent automatiquement leur vitesse en bauds à celle du maître.

5 Dans la fenêtre Insert Master, sélectionnez un maître (par exemple TSX PBY 100) dans la liste 

Available masters. 

Cliquez sur le bouton Add>> et confirmez en cliquant sur OK.

6 Ajoutez un esclave : 

 cliquez sur Insert → Slave..., ou

 sélectionnez .
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7 Dans la fenêtre Insert Slave, sélectionnez LTM R - TeSys T Profibus  dans la liste Available 

slaves. 

Cliquez sur le bouton Add>> et confirmez en cliquant sur OK. L’écran suivant apparaît : 

8 Sélectionnez Slave1 et cliquez deux fois dessus pour ouvrir la fenêtre Slave Configuration :

 Définissez Station address sur 4, par exemple.

 Modifiez la valeur par défaut dans Description (sur MMC_4, par exemple)..

 Sélectionnez le module approprié dans la liste :

Remarque : Passez aux étapes 9 à 12 si un mode de configuration A distance (R) a été sélectionné.

9 Cliquez sur le bouton Parameter Data... pour ouvrir la fenêtre Parameter Data.

10 Cliquez sur le bouton Module pour ouvrir la fenêtre Parameter Data correspondante et définir les 

valeurs des paramètres.

11 Cliquez deux fois sur l'un des paramètres disponibles (par exemple, Fallback strategy). Un tableau 

de choix supplémentaires s’ouvre, vous permettant de changer la valeur du paramètre :

Cliquez sur OK.

12 Cliquez sur le bouton OK de chaque boîte de dialogue ouverte pour confirmer les valeurs de paramètre 

sélectionnées. 

Etape Action
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Enregistrement et exportation de la configuration du réseau

Enregistrez et exportez la configuration avant de l'importer dans la configuration de l'automate (PL7, 

Concept or Unity Pro).

Importation de la configuration réseau dans un automate à l'aide du logiciel Unity

NOTE : La version du logiciel Unity doit être supérieure ou égale à 2.3. 

Exemple d'importation de configuration avec le logiciel Unity : 

Etape Action

1 Sélectionnez File → Save As pour ouvrir la fenêtre Save as.

2 Choisissez un emplacement dans Project path et un nom dans File name puis cliquez sur click Save 

(extension .pb).

3 Sélectionnez File → Export → ASCII pour exporter la configuration en tant que fichier ASCII (extension 

.cnf).

4 Importez la configuration Profibus-DP dans la configuration de l'automate (PL7, Concept ou Unity Pro).

Etape Description

1 Déclarez le module Profibus-DP dans le logiciel Unity :

 Cliquez avec le bouton droit sur l'emplacement où le module doit être déclaré et ajoutez-le.

 Sélectionnez TSXPBY100 dans la famille Communication et cliquez sur OK pour confirmer.

2 Configurez le module Profibus-DP dans le logiciel Unity :

 Cliquez deux fois sur le module Profibus-DP pour ouvrir la fenêtre de communication. 

 Cliquez sur Load CNF.

 Sélectionnez le fichier de configuration de bus ASCII :
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3 Configurez les options utilisateur :

 Type de tâche (Mast ou Fast).

 Etat de la sortie lorsque la tâche est arrêtée.

 Nombre total de %IW/%QW : 32.

 Nombre d’octets de diagnostic : 44 pour TeSys®T.

4 Vérifiez la configuration : 

 Cliquez sur le bouton Affichage pour vérifier le paramètre du maître.

5 Transférez la configuration vers l'automate et exécutez-la : 

 Cliquez sur OK pour fermer la fenêtre de vérification.

 Cliquez sur Validate pour confirmer la configuration.

 Chargez le fichier de configuration dans l'automate et exécutez-le.

6 Test de communication : 

 Ouvrez l'écran de mise au point afin de lire et d'écrire les données de cycle.

7 Développez et chargez le programme d'application, puis testez-le.

Etape Description
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Test de communication Profibus-DP : 

Les informations de configuration de base utilisant les registres de surveillance, de contrôle et de 

configuration sont valables pour toutes les applications :

Organisation des données cycliques

Données d'entrée : 10octets

Données de sortie : 6octets

Données d’entrée

Données d’entrée cycliques :

Entrées 0 et 1 Etat du contrôleur (profil MMS)

Entrées 2 et 3 Courant moyen (reg. 466)

Entrées 4 et 5 Etat des entrées (reg. 457 LB) Etat des entrées (reg. 457 HB)

Entrées 6 et 7 Etat des sorties (reg. 458 LB) Etat des sorties (reg. 458 HB)

Entrées 8 et 9 Etat des entrées (reg. 457 LB) Etat des entrées (reg. 456 HB)

Sorties 0 et 1 Registre de commande (profil MMS)

Sorties 2 et 3 Sorties analogiques (reg. 706 LB) Sorties analogiques (reg. 706 HB)

Sorties 4 et 5 Commande des sorties (reg. 700 LB) Commande des sorties (reg. 700 HB)

Position Description

Entrée 0.0

Marche inverse

Les contacts du circuit principal sont fermés.

Entrée 0.1

Arrêt

Indique que l’équipement est à l’état d’ARRET.

Entrée 0.2

Marche directe

Les contacts du circuit principal sont fermés.

Entrée 0.3

Surcharge thermique - alarme

Une condition d’alarme de surcharge a été détectée.

(461.3)

Entrée 0.4

Temporisation verrouillage

Octet de poids fort du registre des états de communication (456.4)

Entrée 0.5

Mode automatique

Indique à un contrôleur hôte distant que les commandes MARCHE 

DIRECTE, MARCHE INVERSE et ARRET seront ou ne seront pas 

acceptées.

0 = CONTROLE LOCAL

1 = MODE AUTOMATIQUE
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Entrée 0.6

Système - défaut

Il existe une condition de défaut.

(455.2)

Entrée 0.7

Système - alarme

Il existe une condition d'avertissement.

(455.3)

Entrée 1.4

Système - disponible

Prêt

(455.0)

Entrée 1.5

Moteur - en démarrage

Moteur en démarrage

(455.15)

Entrée 1.6

Moteur - en fonctionnement

Moteur en fonctionnement

(455.7)

Entrée 1.7

Système - déclenché

Déclenché

(455.4)

Entrée 2/3

Courant moyen - rapport

Intensité moyenne IAV (% FLA)

(466)

Entrée 4

Entrées booléennes 9-16 du module 

d’extension

Etat des entrées booléennes

octet de poids fort

(457.8-15)

Entrée 5

Entrées booléennes 1-6 du contrôleur LTM R + 

entrées 7-8 du module d'extension LTM E

Etat des entrées booléennes

octet de poids faible

(457.0-7)

Entrée 6

Réservée

Etat des sorties booléennes

octet de poids fort

(458.8-9)

(458.10-15 non significatifs)

Entrée 7

Etat des sorties booléennes 13, 23, 33, et 95

Etat des sorties booléennes

octet de poids faible

(458.0-3)

(458.4-7 non significatifs)

Entrée 8

(456.8) Perte de communication sur le port 

réseau

(456.9) Verrouillage moteur

(456.10-15) Réservée

Registre de l'état du système 2

octet de poids fort

(456.8-15)

Entrée 9

(456.0) Réarmement automatique - actif

(456.1) Réservée

(456.2) Défaut - coupure alimentation requise

(456.3) Moteur - délai redémarrage non défini

(456.4) Cycle rapide verrouillé

(456.5) Délestage

(456.6) Moteur - vitesse 2

(456.7) Port IHM - perte de communication

Registre de l'état du système 2

octet de poids faible

(456.0-7)

Position Description
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Données de sortie

Données de sortie cycliques :

Position Description

Sortie 0.0

Marche inverse

Ordonne au démarreur d'activer le moteur dans le sens inverse.

Sortie 0.1

Arrêt

Indique à l’équipement de passer à l’état d’ARRET.

0 = ACTIVER MARCHE DIRECTE / MARCHE INVERSE

1= ARRET

Sortie 0.2

Marche directe

Ordonne au démarreur d'activer le moteur dans le sens direct. 

Sortie 0.3

Autotest - commande lancement

Commande de l’unité de contrôle

Ordonne à l'équipement de lancer une routine de test interne au 

sein de l'équipement.

(704.5)

Sortie 0.4

Commande effacement - capacité thermique

Réarmement de la mémoire thermique

Ordonne au démarreur de ne pas tenir compte de toute condition de 

défaut et de permettre le démarrage.

(704.5)

Remarque : Cette commande désactive la protection thermique. Le 

fonctionnement continu sans protection thermique doit être limité 

aux applications pour lesquelles le redémarrage immédiat est 

essentiel. En définissant ce bit sur 1, l’état thermique du moteur est 

perdu : la protection thermique n’est plus active pour un moteur déjà 

chaud.

Sortie 0.5

Mode automatique

Indique au démarreur de refuser les commandes Marche inverse, 

Marche directe et Arrêt reçues de l’hôte distant.

0 = CONTROLE LOCAL

1 = MODE AUTOMATIQUE

Sortie 0.6

Défaut - commande réarmement

Réarmement des défauts

Indique au démarreur de réarmer tous les défauts réinitialisables 

(une des conditions prérequises pour l’état PRET).

(704.3)

Sortie 1.4

Spécifique au fabricant 1

Réservée

Sortie 1.5

Moteur - commande vitesse 1

Vitesse 1 (704.6)

Sortie 1.6

Spécifique au fabricant 3

Réservée

Sortie 1.7

Spécifique au fabricant 4

Réservée

Sortie 2

Sortie supplémentaire

Sortie analogique

(706.8-15)

Sortie 3

Sortie supplémentaire

Sortie analogique

(706.0-7)

Sortie 4

Sortie supplémentaire

Registre des commandes du module de communication 1

octet de poids fort

(700.8-15)

Sortie 5

Sortie supplémentaire

Registre des commandes du module de communication 1

octet de poids faible

(700.0-4)

(700.0-5-7 : Réservée)
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